
Section:  Monday / Tuesday Name:    

(circle one) Partners:   

    

PHYSICS 107 LAB #6: SINGING IN THE SHOWER, SINGING 

IN THE CHAPEL:  ROOM ACOUSTICS 

Equipment: computer, headphones, audio splitters, Odeon Program, LoggerPro 

software, LabPros with batteries (take out over night), SIL Meter.  Computer logged in 

as administrator / physics (Odeon doesn’t work well in other account on XP machines) 

 

 

 

 Understand reverberant sound and reverberation time. 

 Understand how the size, geometry and materials in a space affect the behavior of 

sound 

 

 

  

Have you ever wondered what makes the church choir sound so powerful in the chapel? 

Or what exactly makes your shower so great for singing? In this lab you’ll explore the various 

aspects of room acoustics, determining how the geometry and the materials of a given room 

affect sounds as they propagate through it.  You’ll listen to audio simulations of sounds in 

different spaces and hear the differences for yourself; you’ll run a visual/computational 

simulation to see how sound interacts with the different spaces; you’ll go out and measure the 

acoustics of different spaces on campus. 

 Physically, room acoustics depends on the size of a space, which determines how far 

sound travels between reflection, and on the materials of the space, which determines how 

severely different frequencies of the sound are adsorbed upon reflection.  As simple as those 

ingredients are, combined differently, they can give different spaces very distinct audio qualities, 

effecting a sounds clarity (are sounds distinct or muddled), envelopment (does the sound all 

seem to come from the source, or does it come from all around), smoothness (do you hear 

discrete echoes or just single extended sounds), reverberation (does the sound get reinforced and 

extended or is it dead like you’re listening outside.)  While it’s hard to get too quantitative about 

any of these, one quality that’s easily measured is a sound’s duration.  This is quantified in its 

reverberation time – the time required for the sound to drop 60dB below its original intensity 

level.  

 

 

 

 

You will use a computer to model spaces that are similar to those in the previous 

activity.  You’ll be able to see how sound moves through the spaces and reverberation 

times will be calculated.  In this activity, you’ll use a computer to model different spaces 

and both visualize how sound propagates through them and listen to sounds that have 

been processed  as if heard in these spaces.  
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Simulation Background. 

In Odeon, a sharp sound, like that of a single clap, is represented as a shell of balls 

flying out from the sound source.  When they strike surfaces (floors, walls, ceilings, etc.) 

the ‘sound balls’ reflect in the appropriate directions and weaken (represented by a 

change in color.)  In a well designed listening environment, sound uniformly fills the 

space – there are no locations that the sound misses or focuses into.  Conversely, domes 

are famous for focusing sounds from specific source locations into specific listening 

locations (with intriguing consequences when their parts of governmental buildings.)    

In addition to providing a visualization of sound in a given space, Odeon can calculate 

the sound’s reverberation time.  How severely a sound is weakened by reflection from a 

surface depends both on the sounds frequency and the material of the surface.  So, for a 

given space, Odeon calculates reverberation times for ranges of frequencies, and by 

changing the simulation’s building materials you can change those reverberation times.  

 

Open the program Odeon  

 

Concert Hall.  This space is specially designed to give uniform sound coverage and a 

reverberation time appropriate for music.  Let’s see how it does. 
 

1. Visualize sound.  (this is more of a qualitative exploration, so just have fun) 

a. Open the virtual Concert Hall within it by selecting “Open Room” 

from the “File” menu, and then selecting “Elmia RoundRobin2 

detailed.Par” (let your instructor know if you can’t find it.)   

 
b. Notice the reflector panels in the room’s ceiling.  To see their effect, 

click on the “3D Reflector Coverage” button on the top toolbar (6
th

 

from the right) or hit Shft+Ctrl+C.  The panel segments and the 

surfaces to which they reflect sound are color coordinated. 

 Note:  The line-drawing of the room can be rotated by clicking 

and dragging with the mouse, moved by right-clicking and 

dragging, and zoomed in and out with Ctrl+U and Ctrl+I, 

respectively. 

c. To run the simulation, click on the “3D-Billiard” button on the top 

toolbar (fourth from the right) or hit Shift+Ctrl+B.  Observe how the 

sound fills the space. 

Note: you can choose to view different slices of the source sound 

(x-y, y-z, x-z, or 3D Random) at the right of the visualization 

window.  Try some of them.  
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2. Determine Reverberation. 

a. Click the “Global Estimator” button at the top of the screen (11
th

 from 

the right) or hit Sft+Ctrl+E.   

Note: you’ll need to close the “3D-Billiard” window for the Global 

Estimator window to come up. 

b. To set it running, you may need to hit the “recalculate” button at the 

bottom of the screen.   

c. After about half a minute, the calculations should converge (the plot 

getting drawn should stop squiggling).  Then hit the “Derive Results” 

button at the bottom, and then the “Yes” button in the pop-up. 

d. You’ll see a plot of how different frequency sounds weaken with time.  

In the box to the right will be a list of reverberation times for the 

different frequencies.  Alternatively, you can see the Reverberation 

Times plotted if you select the “Estimated Reverberation Times” tab. 

(T20 and T30 denote slightly different ways of calculating the times – 

if their values differ significantly, the simulation needs to be run 

longer.) 

 

Question:  Which frequency dies off fastest?  What’s its reverberation 

Time? 

 

 

 

Question: Which frequency lasts longest?  What’s its reverberation Time? 

 

 

 

Question:  There’s a range of reverberation times for the different 

frequencies, but think about what’s a representative / average time, then 

looking at your book’s Figure 15.10, what kind of performances would 

this space be good for? Note: the room’s volume is estimated on the 

“Energy Curves” page in Odeon. 

 

 

 

 

 

Keeping the program open, close all windows within it except the simple 

3D View. 

3. Hear Sound. 

a. Auralization Setup – hit Shift+Cntrl+A to open the Auralization Setup 

window; make sure that the “create binaural impulse response file” 

box (second from top on left) is checked and then close the window. 

b. Job List – hit Shift+Cntrl+J to open the Job List window.  Job 1 should 

already be highlighted in the list; click on Job 3 instead.  You’ll see 

that the sound source location is represented in with a red dot in the J 
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picture of the room and the microphone’s location is represented with 

a teal dot. 

c. Run Job – hit Alt+R; if it has already been run, then a pop-up box will 

tell you so, and you can dismiss it. 

d. Play Sound – hit Alt+C; in the window that opens, you can use the 

“signal file” menu to choose what sound to hear.  Listen to the four 

different sound sources in this space: clap, the quickly played piano, 

the slowly played viola, and the spoken word (you can check and 

uncheck the “listen to input signal” box for comparison.) 

 

 

Question:  Describe how the space affects the sound; consider the clarity, 

envelopment, smoothness, reverberation,… 

 

 

 

 

 

 

 

Question:  What kind(s) of sound (speech, chamber music, orchestral 

music…) might this space be good or bad for? 

 

 

 

 

 

 

Chapel.  This space was designed before room acoustics became a real science, so it’s 

beautiful, but there’s no guarantee about uniform coverage or that the reverberation time 

will be suitable for a wide range of sounds.  Let’s see how it fairs. 

1. Visualize Sound. (this is more of a qualitative exploration, so just have fun) 

a. Open the virtual Chapel within it by selecting “Open Room” from the 

“File” menu, and then selecting “Hagia Irene.Par”; a pop-up window 

will ask you to verify that you’re done working with the concert hall.  

b. This time, run the ray-trace simulation (5
th

 button from the right or 

Sft+Ctrl+I), this allows you to follow the path of individual ‘sound 

balls.’  

i. Check the OK box at the bottom, then hit the “Single Ray” 

button a few times.  Notice how some of the sound rays get 

‘trapped’ in different spaces. 

c. Now to see the focusing effect of the dome, run the 3D-Billiard 

simulation (fourth from the right or hit Shift+Ctrl+B) and select from 

the “source” menu at the right source 4 (in the dome).   It’s particularly 

striking if you select “none” in the Diffusion box at the right.  

2. Determine Reverberation. 

a. Click the “Global Estimator” button at the top of the screen (11
th

 from 

the right) or hit Sft+Ctrl+E.  Note: it will probably freeze before 
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completing the calculation – don’t hit “ok” in the pop-up box.  The 

reverberation time is how long it takes for the SIL to drop by 60dB, 

you should be able to get a ballpark value from what’s already been 

plotted. 

 

 

Question:  What’s the typical reverberation time in this space? 

 

 

 

Question:  Looking at your book’s Figure 15.10, what kinds of sound 

would this space be suited for (if any)? 

 

 

 

 

Keeping the program open, close all windows associated with the chapel. 

 

3. Unfortunately, the chapel model is ‘leaky’, and you can’t listen to the sound in 

this space. 

 

Bathroom  

1. Visualize Sound. 

a. First select “Open Room” from the “File” menu, and open “Transmission 

Rooms.Par” (as a bonus, you also get to see how sound transmits through 

walls between adjoining rooms.) All the surfaces are set to ‘glazed tile’ – 

not much different from a bathroom. 

b. We’ll be focusing on the back left space; first, we’ll want to adjust the 

surface materials to be appropriate for a bathroom – tile, glass, and 

plasterboard. 

i. Click on the “Material List” button on the top toolbar or hit 

Shift+Ctrl+M, and within the pop-up window.  

ii. In the table on the left (listing all the surfaces),  the far left column 

gives the “Surface” number, and the next column gives the 

“Material” number; make surfaces 22 and 26 be material # 2001 

(marble or glazed tile); make surfaces 23 and 25be material #4046 

(plasterboard);  surface 27 material number #4038 (Acoustic 

Plaster); and surface 28 be material #10005 (glass).  

c. Use the 3-D Billiard or Investigate Rays (or both) to see how sound 

bounces in this space.  

2. Determine Reverberation time. 

a. Use the Global Estimator to calculate reverberation times. 

 

Question:  Which frequency dies off fastest?  What’s its reverberation Time? 
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Question: Which frequency lasts longest?  What’s its reverberation Time? 

 

 

 

 

 

4. Hear Sound. 

a. Auralization Setup – hit Shift+Cntrl+A to open the Auralization Setup 

window; make sure that the “create binaural impulse response file” 

box (second from top on left) is checked and then close the window. 

b. Job List – hit Shift+Cntrl+J to open the Job List window.  Job 1 should 

already be highlighted in the list; if not, select it so it becomes 

highlighted.  You’ll see that the sound source location is represented in 

with a red dot in the picture of the room and the microphone’s location 

is represented with a teal dot. 

c. Run Job – hit Alt+R; if it has already been run, then a pop-up box will 

tell you so, and you can dismiss it. 

d. Play Sound – hit Alt+C; in the window that opens, you can use the 

“signal file” menu to choose what sound to hear.  Listen to the four 

different sound sources in this space: clap, the quickly played piano, 

the slowly played viola, and the spoken word (you can check and 

uncheck the “listen to input signal” box for comparison.) 

 

Question:  Describe how the space affects the sound; consider the clarity, 

envelopment, smoothness, reverberation,… 

 

 

 

 

 

 

 

Question:  What kind(s) of sound (speech, chamber music, orchestral 

music…) might this space be good or bad for? 

 

 

 

 

 

 

 

(empty) Dorm Room  

1.  Modify the Room  

b. You’ll probably need to close all of the windows except the simple 3D 

view.  Now modify one of the rooms to be a typical dorm by changing the 

surface materials as follows. 

i. Click on the “Material List” button on the top toolbar or hit 

Shift+Ctrl+M, and within the pop-up window.  

J 
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ii. In the table on the left (listing all the surfaces),  the far left column 

gives the “Surface” number, and the next column gives the 

“Material” number; make surfaces 23,25, and 28 material #4049 

“Plasterboard (with mineral wool)”, surface 26 material #8011 

“Curtains”, surface 22 material #7001 “6mm pile carpet”, and 

surface 27 material number #4038 “Acoustic Plaster.” 

2.  Visualize Sound. 

c. Use the 3-D Billiard or Investigate Rays (or both) to see how sound 

bounces in this space.  Note: a pop-up box will ask you to confirm that 

you want to calculate new data using your new surfaces – click “yes.” 

3. Determine Reverberation time. 

a. Use the Global Estimator to calculate reverberation times. 

 

 

Question:  Which frequency dies off fastest?  What’s its reverberation Time? 

 

 

 

Question: Which frequency lasts longest?  What’s its reverberation Time? 

 

 

 

 

4.  Hear Sound. 

e. Auralization Setup – hit Shift+Cntrl+A to open the Auralization Setup 

window; make sure that the “create binaural impulse response file” 

box (second from top on left) is checked and then close the window. 

f. Job List – hit Shift+Cntrl+J to open the Job List window.  Job 1 should 

already be highlighted in the list; if not, select it so it becomes 

highlighted.  You’ll see that the sound source location is represented in 

with a red dot in the picture of the room and the microphone’s location 

is represented with a teal dot. 

g. Run Job – hit Alt+R; if it has already been run, then a pop-up box will 

tell you so, and you can dismiss it. 

h. Play Sound – hit Alt+C; in the window that opens, you can use the 

“signal file” menu to choose what sound to hear.  Listen to the four 

different sound sources in this space: clap, the quickly played piano, 

the slowly played viola, and the spoken word (you can check and 

uncheck the “listen to input signal” box for comparison.) 

 

Question:  Describe how the space affects the sound; consider the clarity, 

envelopment, smoothness, reverberation,… 

 

 

 

 

 

J 
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Question:  What kind(s) of sound (speech, chamber music, orchestral 

music…) might this space be good or bad for? 

 

 

 

 

 

Question:  There’s a range of reverberation times for the different 

frequencies, but think about what’s a representative / average time, then 

looking at your book’s Figure 15.10, what kind of performances would 

this space be good for? Note: the room’s volume is estimated on the 

“Energy Curves” page in Odeon. 

 

 

 

 

 

For easy comparison, copy the reverberation time values to the table below. 

 
 
 
 
 

 Now you will be able to use a LabPro to go around campus and measure the 

reverberation times in several different locations. You will then report back to the 

classroom to construct somewhat of an “Acoustical Map” of the campus using all of the 

class data.  

 

1. First, to get practice we’ll measure the reverberation time of the lab room. 

a. With the Sound Intensity Level Meter (SLM) plugged into the LabPro, 

open “Room Acoustics” from the “Physics Experiments” folder on the 

computer’s desktop. 

b. Turn on the SLM in the Lo setting (35-90dB), and set for fast response 

(the F/S switch set to F). 

c. Now, when you’re ready, hit the green “collect” button in the LoggerPro 

program – it won’t start collecting data until you clap.  So clap four or five 

times at least a meter from the detector (so the direct sound isn’t too loud 

for it.)  Each clap should be registered as a sharp spike with a gradual 

decay. 

Reverberation Time Summary 

Concert Hall Chapel Bathroom Dorm Room 

Max: 

 

Min: 

Typical: Min: 

 

Max: 

 

Min: 

 

Max: 
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d. When LoggerPro is done collecting data (it runs for only about 10 

seconds), you’ll want to determine the initial slope of the decay curve for 

each clap. To analyze the data do the following for each peak: 

i. First zoom in on the peak and the tail that trails behind it, to do this 

highlight the area you wish to zoom in on and then push the button 

that looks like a magnifying class with a “+” in it.  

ii. Then determine the initial slope of peak’s decay – so from the peak 

to about half-way down.  To do this, highlight the desired region 

and then click the Linear Fit button (Looks like “R=”) on the top 

toolbar.  Note: two square brackets, [ and ], will mark the region of 

data being fit – you can click on and drag the brackets to change 

the region. 

iii. The pop-up box will give the fitting line’s slope; copy that into the 

data table below. 

iv. Then perform the following calculation: 

 and enter your answer into 

the data table on the next page. 

e. Since you clapped a few times, there are a few peaks; for three more 

measure their slopes and determine the corresponding reverberation times 

(they should all be about the same as each other.)  

 

 

2. You’re going to go measure the reverberation time of some other room of your 

choice; but first, you’ll practice using the LabPro “remotely” here in the class 

room. 

a. Very first thing, you’ll want to clear the old data (LoggerPro tends to error 

when importing remotely collected data into a file that already has data). 

i. Under the Data menu, select Clear Data. 

b. Now you will need to set up the LabPro so that it can be used in its remote 

setting. 

i. Select “Remote” from the “Experiment” menu, then “LabPro: 1” 

under “Set Up.” 

ii. Click “Ok” in the two pop-up boxes that appear. 

iii. When instructed to do so, unplug the LabPro from the computer 

and from its power cable. You are now ready to “remotely” collect 

your data. 

c. When you are ready, push the “Start/Stop” button on the LabPro and the 

central light should blink orange.  Clap 4 - 5 times some distance from the 

Location:   

Lab Room 

Slope 

(dB/s) 

Reverberation 

Time (s) 

Average 

Reverberation 

Time: (s) 
Clap1   

Clap 2   

Clap 3   

Clap 4   

R= 
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SLM.  Do not press “Start/Stop” a second time. Once your 10 seconds of 

data collecting are up, the central light will blink orange once more.  

d. Plug the LabPro back into the computer and into its power cord.  A pop-up 

box should ask you if you want to import your data - “yes.”  

e. If LoggerPro plots your remote data, you did everything right, and you’re 

ready to do it for real! 

3. Now you’re ready to get remote data from another room, say, the bathroom, 

Hedco’s entry, the chapel (if no one’s using it), your dorm,…wherever you like. 

a. Again, set up LabPro for remote collection, as in part 2 above, then go to 

your chosen space and collect data. 

4. Return to the lab and attach the LabPro back into the computer using a USB cord. 

Once connected, open LoggerPro and a box should appear and be sure to import 

the data.  

5. Now you’ll analyze the data as you did before (1.d on the previous page) and fill 

in the table on the next page. 

 

6. Once you have finished your data, enter in your average reverberation time into 

the class data table on the board and be sure to also copy down everyone else’s 

data as well. 

 

 

 

 

 

 

 

 

 

 

 

Question: How does the class data compare to what you’d expect for the variety of 

rooms; are the ones with longest or shortest reverberation times the ones you’d expect 

based on the simulations you did earlier in the lab? 

 

 

 

 

 

 

Location: Slope 

(dB/s) 

Reverberation 

Time (s) 

Average 

Reverberation 

Time: (s) 
Clap1   

Clap 2   

Clap 3   

Clap 4   

Location Average Reverberation Time (s) 
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